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1 WELCOME 

Welcome to Maros 9.3.1. 

Maros 9.3.1 is now able to handle bottlenecks. Previously, Maros has validated the production profile 

of all product streams against the design capacity of each node and its respective parallel blocks. 

This makes sense during the design-phase where analysts are planning to design an unconstrained 

production system. However, during the operational-phase, design is fixed which does not give 

flexibility to change the capacities. To overcome this challenge, the new feature will allow these 

bottlenecks to be simulated and analysed. 

 

Figure 1: “Allow bottlenecks” in the Settings tab  

This is added to the features released in Maros 9.3: an alternative to the existing flow method, more 

stability and more usability features. 

The new flow solver is part of the initial implementation of optimisation methods in Maros. The solver 

is a Mixed Integer Linear Programming (MILP) type of a solver based on the revised simplex method. 

This method focuses on setting up an objective function which represents the target to be optimised. 

The objective function would typically refer to an export node which will be used as a reference for 

the flow calculation. Other nodes could be selected as part of the flow calculation – for example, the 

user could try to minimise the amount of gas flared by adding a minimisation function to the flare 

node. 

 

Figure 2: New “Solver Configuration” tab at the Simulation Parameters 
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Furthermore, improvements to the interface have been introduced based on customer feedback to 

the recent change of the Ribbon Tabs. For example, the zoom bar has been moved to the bottom 

right of the application leaving more space to the Home Tab. Additionally, the Grid button has been 

removed and a new layout introduced to make it easy to access the different grids. 

 

Figure 3: New layout for the Home Tab 

The flaring operations have been improved to allow users to define restart delay. Most flaring 

operations wouldn’t allow for immediate restart as the structure needs to some time to cool off before 

the burning operation can take place again. Thus, if the continuous flaring limit has been breached, 

flaring will not be allowed to restart until the restart time is complete.  

 

Figure 4: Flaring Limits with new Restart Delay 

A new Comparison View has been added to the Results View application allow users to easily compare 

results from multiple cases. 
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Figure 5: New Comparison Mode at the Results View 

This version also introduces the concept of Rate Operations. This feature allows users to control the 

production rate of a node based on the level of a storage tank. For example, if a common operation 

is set to take place between the tank level ranges of 50 - 55% in the attempt to stem the rising tank 

level, then whenever the level rises above 50% the action will begin. This common action remains 

in place until the tank level falls below the 50% threshold again (if no allowance is used for the end 

action). 

 

Figure 6: Buffer Level Management in the Animation Mode 

We hope you enjoy the experience of using Maros 9.3.1.  

Please let us know what you think at software.support@dnvgl.com or sending your feedback directly 

to Victor Borges.  

Your comments, suggestions and requests will help us shape the further evolution and improvement 

of DNV GL’s RAM software tools. 

2 WHAT’S NEW? 

Several features have been introduced empowering you to model several scenarios which were not 

previously available. A summary of the new features follows. 

http://www.wipo.int/contact/en/area.jsp?area=web
mailto:software.support@dnvgl.com
mailto:victor.borges@dnvgl.com


   

| Release Notes | Maros 9.3.1 | June 2017 | www.dnvgl.com/software  Page 5 

 

 Debottlenecking feature 

An offshore production facility is under operation (past the design phase) described using the 

following block flow diagram: 

 

Figure 7: Block Flow Diagram 

The main assumptions for this case study are listed below: 

- The node design capacities are indicated in parenthesis. Each export node has the node 

design capacity of  

o Oil export: 100 mbbls/day 

o Water production: 100 mbbls/day 

o Gas compression: 100 mmscf/day 

- Two systems are defined: Compression and Pumping system 

- Each system is formed with parallel blocks with one equipment item 

- Each parallel block unit are using the following capacities: 

Table 1: Parallel Block capacity per unit 

Parallel Block Equipment Unit 1 Unit 2 

Compression Compressor 75 mmscf/day 75 mmscf/day 

Pumping 

system 
Pump 60 mbbls/day 60 mbbls/day 

The reservoir profile is described using the following production profile: 
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Figure 8: Oil, Water and Gas Production Profile 

A new reservoir profile is calculated where the water production has increased considerably for the 

next 10 years.  

 

Figure 9: Water Production profile for Base case and Sensitivity case 

Adding this new production profile at the Flow Grid in Maros will prompt the following error message 

in the Water Production Node: 

 

Figure 10: Error message when production is bottlenecked by Node Design Capacity 

As the error indicates, the node capacity of 100 mbbls/Day is not sufficient to handle the newly 

defined flow of 125 mbbls/day. Maros will identify all nodes where the system is unable to process 

the production rates defined at the Flow Grid. 

As the error message indicates, this problem can be resolved by:  
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- Change the Node Design Capacity to meet the peak production rate for the associated stream 

in the Flow Grid or; 

- Select the option to "Allow Bottlenecks" in the Settings tab 

The first solution is not feasible for assets that are under operations – design configuration is fixed. 

Thus, to allow the model to run with this current bottleneck, the user needs to select the option to 

"Allow Bottlenecks" in the Settings tab: 

 

Figure 11: Allow Bottlenecks in the Setting Tab 

This will convert the error message into a warning message. The red icon indicates an error message 

and you cannot run the model . The yellow icon  indicates a warning which will allow you to 

run the model but made you aware of a specific issue in the model. 

This will impact mainly two areas of the flow calculation: 

 Bottlenecked production caused by the inability to flow all the water production and the 

requirement to maintain the gas and oil ratio (GOR) 

 Spare capacity available when the nodes are not 100% utilized 

This is discussed in more details in the manual.  

 Alternative flow optimisation solver 

The new flow solver is part of the initial implementation of optimisation methods in Maros. The solver 

is a Mixed Integer Linear Programming (MILP) type of a solver based on the revised simplex method. 

This method focuses on setting up an objective function which represents the target to be optimised. 

The objective function would typically refer to an export node which will be used as a reference for 

the flow calculation. Other nodes could be selected as part of the flow calculation – for example, the 

user could try to minimise the amount of gas flared by adding a minimisation function to the flare 

node. 

The new flow solver is better explained by the means of an example.  

The following Block Flow Diagram describes a system where two wells feed into a separation system 

and two products are then exported – oil and gas.  

 

Figure 12: Block Flow Diagram for typical oil and gas system 
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The two wells are defined with the following production rates: 

- Well 1 produces 50 mbbls per day of oil and 40 mmscf per day of gas 

- Well 2 produces 40 mbbls per day of oil and 50 mmscf per day of gas 

Thus, Well 1 is rich in oil with a smaller gas and oil ratio (GOR) when compared to Well 2. The 

following two graphs show the expected production rate coming from each well: 

 

Figure 13: Oil Production profile 

 

Figure 14: Gas Production profile 

In addition, a demand profile of 75 mbbls per day is defined to control the production of oil exported: 

 

Figure 15: Solid line showing the demand profile 
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The objective function would typically be defined after setting up the block flow diagram. This will 

ensure that the normal behaviour of the network is described in detail after moving into the 

subsequent modelling steps e.g. production profile definition, setting up Reliability Block Flow 

Diagrams, Operations and Maintenance strategy definition etc. 

For this example, we are interested on how Maros is calculating the normal flow i.e. the flow when 

no event is occurring. 

The objective function is defined at the Simulation Parameters window by selecting the “Solver 

Configuration” tab. Users can then select between two flow solvers: 

- Balance feed: existing flow solver where feeds are balanced 

- Objective based solver: flow solver based on optimisation methods 

By selecting the Objective based solver approach, the grid area will be made available for users. If 

no objective function is defined, Maros will maximise the export node as mentioned by the message 

at the bottom of the Simulation Parameters window. 

 

Figure 16: Solver configuration tab in the Simulation Parameters 

Upon pressing “Ok” and selecting to display the Block Flow Diagram, a new icon that looks like a 

target will be shown in the export node. If the user passes the mouse pointer over the icon, a 

message indicating that this node is associated with an objective function is displayed, as shown 

below. 
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Figure 17: Icon shows the node that has been selected as a target in the objective 
function 

Running the model considering this approach will optimise the amount of oil being exported. This 

means that Maros will calculate the flow by taking production from the wells with the highest flow 

rate of oil which, in our example, is Well 1.  

Playing the animation mode will show that under normal operations, Maros is taking most production 

from Well 1. 

 

Figure 18: Normal production when using optimising oil export 

The next step of this example is to maximise the production of gas. Thus, the user would be required 

to change the objective function. This can be accessed by double-clicking target icon or going back 

to the Simulation Parameters window and selecting the “Solver Configuration” tab. 

To add a new objective, the user must simply press the “Add” button on the top-right. Alternatively, 

right-clicking on “Row” column to the left will give users the ability to add new rows. Objective 

functions (i.e. targets) can be transient as the target of optimisation can change with time e.g. 

initially focus on optimising oil and, in a later stage, focus on reducing water production. 



   

| Release Notes | Maros 9.3.1 | June 2017 | www.dnvgl.com/software  Page 11 

 

 

Figure 19: Defining new objective function 

After clicking on “Add” or selecting to add a new row, the objective cell will be empty and the buttons 

at the bottom of the screen will be enabled. These buttons will the user the ability to select whether 

to maximize or minimize the production of a specific node.  

Since our example is trying to maximise the production of gas, the user would need to click on the 

Maximise button which would prompt another window. This window allows users to select what is 

the target (i.e. node) of the maximisation process. 

 

Figure 20: Node selection 

This list can be expanded to display all nodes and its associated product streams by unchecking the 

box to “Show only Exports”. 



   

| Release Notes | Maros 9.3.1 | June 2017 | www.dnvgl.com/software  Page 12 

 

 

Figure 21: Displaying all nodes 

If the “Gas export” is selected and pressing “Ok”, the new objective is added to the list.  

 

 

Figure 22: New objective function define, focusing on gas export 

After pressing “Ok” to the Simulation Parameters window, the target icon will move to the 

“Compression system” node indicating that this is the new target. 
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Figure 23: New icon describing the new objective function 

After running the simulation and selecting to play the Animation mode, the normal production rate 

is displayed by all nodes: 

 

Figure 24: New normal production when the gas production is optimised 

Now the production rate for Well 2 is maximised because this well will deliver more gas when 

compared to production taken from Well 1. 

This version of the solver covers all features available in Maros except for shipping modelling, storage 

modelling and prioritised boosting. 

 Extended flaring operations  

The flaring operations have been improved to allow users to define restart delay. Most flaring 

operations wouldn’t allow for immediate restart as the structure needs to some time to cool off before 

the burning operation can take place again. Thus, if the continuous flaring limit has been breached, 

flaring will not be allowed to restart until the restart time is complete.  

To define flaring operations, the first step is entering a unique flare limit description at the 

“Description” field. 

Following this step, the user must select the appropriate flare limit type depending on the given 

restrictions. The restriction can either be a limit based on: 

 the volume allowed to be flared; 

 the percentage of potential volume; or 

 a limit on the length of time flaring is allowed.  

It is important to note that all flaring limits in the model must have the same flare limit type. 
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Figure 25: General Flare Limit Page 

The following section describes the Time-based limit in detail in the context of the Restart delay 

feature:  

Time-based flaring limits 

The Max. Cumulative Flaring is the maximum duration (in hours) that a system can flare within 

the defined accounting period. This is irrespective of the number of times flaring has occurred within 

this period. 

The Continuous Flaring allows the user to define a continuous limit to the flaring operations. Most 

flaring operations wouldn’t allow for immediate restart as the structure needs to some time to cool 

off before the burning operation can take place again. Thus, if the continuous flaring limit has been 

breached, flaring will not be allowed to restart until the restart time is complete. If this field is left 

blank flaring can restart after the downstream bottleneck has cleared (backward compatibility for 

simple models) or 24 hours (for complex models e.g. models with multiple flares or merged flow). 
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Figure 26: Flare Limit with Time defined as a Limit Type 

For example, taking a model where the compression failure lasts for 10 days and a time-based limit 

is defined. The time-based limit configuration is defined using the following parameters: 

 Max. Cumulative Flaring (hrs): 1000 hours 

 Max. Continuous Flaring(hrs.): 24 hours. 

If the “Restart Delay (hrs)” is left blank, the flaring can restart after the downstream bottleneck has 

cleared. The following graph shows the flaring rate compared to the oil production rate when the 

event occurs. The timeline is described as: 

 01/01/2020: Failure occurs at the compression system.  

o Oil production rate equals 0% and; 

o Flare burning rate equals 100%. 

 02/01/2020: 24 hours of continuous limit is breached.  

o Oil production rate equals 0% and; 

o Flare burning rate equals 0%. 

 11/01/2020: 9 days later the failure is repaired i.e. the downstream constrain is removed. 

o Oil production rate equals 100% and; 

o No need to flare. 
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Adding a 24 hours’ restart delay would enforce the rule set where the flare operations will be allowed 

to take place every 24 hours. This will describe the following behaviour: 

 01/01/2020: Failure occurs at the compression system.  

o Oil production rate equals 0% and; 

o Flare burning rate equals 100%. 

 02/01/2020: 24 hours of continuous limit is breached.  

o Oil production rate equals 0% and; 

o Flare burning rate equals 0%. 

 02/01/2020: 24 hours of continuous limit is breached.  

o Oil production rate equals 0% and; 

o Flare burning rate equals 0%. 

 03/01/2020: 24 hours after the continuous flare was breached – end of Restart delay. 

o Oil production rate equals 0% and; 

o Flare burning rate equals 100%. 

 

From the above graph, one can see that the application will test whether flaring operations should 

take place to every time the restart delay is ended, after a continuous limit is breached. 

If the user checks the box not allowing for immediate flare restart – this will follow a similar behaviour 

compared to the first example. The application will only allow the system to flare when the 

downstream constrain is completely removed. 
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 Rate Operations based on Buffer Level Management 

Storage tanks are an important part of the performance modelling calculation. There are three main 

functions: storage of feedstock to supply a process; storage of product from a process prior to export; 

and intermediate storage between processes. 

The different functions performed by the storage tank are mainly the status of the inflow, outflow 

and required flow of the tank: 

 Rising the level of the storage tank: Inflow > Outflow 

 Emptying the level of the storage tank: Inflow < Outflow 

 Maintaining the level of the storage tank: Inflow = Outflow 

To offer more flexibility over controlling storage levels and how different nodes operate, the Rate 

Operations feature has been extended to Maros. 

The following scenario describes an example of how this feature could be implemented – three nodes 

are describing an import system, the storage node and export system. The Node Design Capacity of 

each node is 100 units per day and the production rate is 100 units per day. 

Using Level Control to control product rate on the network 

This example uses the level of the tank to control the production rates throughout the block flow 

diagram. This is to allow the storage tank to operate partly full. This covers an operation where the 

user wants to mitigate failures upstream of the tank, by having some product stored, and 

downstream of the tank, by ensuring some the tank is not always full. 

To model this scenario, the user must incorporate Level Control operations to the model– this is 

defined at the Node Properties window by selecting the Level Control: 
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Figure 27: Buffer Level Management Settings 

Considering that the operation requires the level of the buffer tank to be maintained at 50%, the 

level control rule could change the feed to 90 units per day when the level of the tank is between 

50% and 55%. 

 

Figure 28: Buffer Level Management Settings  
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To return to 50% in case of the tank topping-up, the inflow of the tank must be smaller than the 

outflow so a second ruleset must be defined between 55% and 100% with a flow that is smaller than 

90 units per day e.g. 75 units per day. 

 

Figure 29: Buffer Level Management Settings  

This will also ensure that, in the case of a downstream failure, a smaller rate will be used to fill-up 

the tank. This will give more time to repair the downstream failure as the storage tank will take 

longer to top-up. 

Table 2: Status of Storage tank 

Scenario Inflow Outflow 
Customer 

node 
Comments Animation 

Normal 

production. 

Storage tank 

is below 50%. 

100 

units/day 

90 

units/day 

90 

units/day 

Inflow is boosted 

making it greater 

than outflow. 

Tank start filling-

up. 

 

Normal 

production. 

Storage tank 

reaches with 

50% and rate 

of feed 

changes to 90 

units per day. 

90 

units/day 

90 

units/day 

90 

units/day 

Inflow equals out 

flow. 

Tank level 

remains constant 
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Scenario Inflow Outflow 
Customer 

node 
Comments Animation 

Upstream 

failure when 

tank is at 50% 

0 

units/day 

90 

units/day 

90 

units/day 

 

Outflow greater 

than inflow. Tank 

start emptying. 

 

Upstream 

failure when 

tank is empty 

0 

units/day 

0 

units/day 

0 

units/day 

Outflow goes to 

zero because of 

tank empty. 

 

Normal 

production. 

100 

units/day 

100 

units/day 

100 

units/day 

Delivery to 

Customer is 

boosted for the 

remaining 

contract period. 

 

Normal 

production. 

Storage tank 

is below 50%. 

100 

units/day 

90 

units/day 

90 

units/day 

Inflow is boosted 

making it greater 

than outflow. 

Tank start filling-

up. 

 

Normal 

production. 

Storage tank 

reaches with 

50% and rate 

of feed 

changes to 90 

units per day. 

90 

units/day 

90 

units/day 

90 

units/day 

Inflow equals out 

flow. 

Tank level 

remains constant 

 

Downstream 

failure when 

tank is at 50% 

90 

units/day 

0 

units/day 

0 

units/day 

Inflow greater 

than out flow. 

Tank start filling-

up. 
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Scenario Inflow Outflow 
Customer 

node 
Comments Animation 

Downstream 

failure when 

tank is full 

0 

units/day 

0 

units/day 

0 

units/day 

Inflow goes to 

zero because of 

tank is full. 

 

Normal 

production. 

Tank is partly 

full. 

75 

units/day 

100 

units/day 

100 

units/day 

Delivery to 

Customer is 

boosted for the 

remaining 

contract period. 

Inflow remains 

at 75 units/day, 

respecting level 

control rule. 

Tank start 

emptying. 
 

Normal 

production. 

Tank is 

between 55% 

and 100%. 

75 

units/day 

90 

units/day 

90 

units/day 

Outflow greater 

than inflow. Tank 

continuous 

emptying. 

 

Normal 

production. 

Storage tank 

reaches with 

50% and rate 

of feed 

changes to 90 

units per day. 

90 

units/day 

90 

units/day 

90 

units/day 

Inflow equals out 

flow. 

Tank level 

remains constant 

 

 New Comparison View 

The Comparison View provides the ability to compare the results between different models. Typically, 

this would involve comparing the results between a base case and its sensitivity scenarios. However, 

the comparison view is not limited to models that are sensitivity cases – it will try to compare the 

results from different models when is possible. 

Upon completion of the simulation process, the Results View will display two options on the top of 

the folder view: Base and Comparison. 

The Base refers to the Base Case model and will display all the results for the model currently loaded: 
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Figure 30: Results View 

By checking the option "Comparison", the Results View will change its layout. A colourful column will 

display the results from the Base Case. 

 

Figure 31: Results View in Comparison mode 

A colourful column will display the results from the Base Case.  

2.5.1 Adding a Comparison case 

In order to add new cases for comparison, click on the hyperlink to the right of the Base Case legend: 
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Figure 32: Clicking on the hyperlink 

This will prompt another window that allows the user to select a Results Database (e.g. file extension 

dmsd for Maros and dtrd for Taro): 

 

Figure 33: Results database selection 

After selecting the Results Database and clicking on Open, the new result set will be added to the 

Comparison View. A colour coding legend will separate the base case from the sensitivity case. The 

sensitivity case will take the Sensitivity Set name and it will show the results for the modified model. 

If the model name is an extension of the base case's name, the Comparison View will display only 

the extension e.g. Base Case = NUI.dmsd and Sensitivity Case = NUI – Sensitivity 1.dmsd; the 

display will show: Base Case = NUI and Sensitivity Case = Sensitivity 1. 
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Figure 34: Results for both models in the Comparison View 

To replace an existing comparison model, click on the model to be replaced and the window will be 

shown again.  

To add more sensitivity cases to the Comparison View, simply click on the hyperlink again and select 

another Results Database. The results of up to four models can be displayed at the same time – one 

base case and three sensitivity case. 

2.5.2 Results display 

All the results comparisons are shown in the tabular format. In addition, many of the results can be 

displayed as graphs benefiting the users greatly in a more user-friendly results comparison. 

 

Figure 35: Similar options to display the results are also available for the Comparison 

View 
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Figure 36: Example of graphical format for Criticality results 

Another useful feature is the ability to display the delta between the different KPIs. By clicking on 

the top right of the screen will show 

 

Figure 37: Display the delta between two values 

 

Figure 38: Delta View compares the results of the Base case with the Sensitivity models 

This will display the delta between the Comparison case and the base case i.e. Potential Volume from 

NUI.dmsd compared to Sensitivity 1.dmsd and Sensitivity 2.dmsd. 
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The number of results folder available will depend on the features defined for the model. Currently, 

the Comparison view handles the following KPIs: 

 Event Criticality 

 Element Criticality  

 Subsystem Criticality 

 Element Type Criticality 

 Availability 

 Plant Performance Summary  

 Buffer Efficiency  

 Bulk Transport Group Utilization  

 Performance Signature 

 Production Efficiency 

 Resource Utilization 

 Consumption of Spares 

 Outage Report 

 Contract Losses 

 Net Present Value  

In case there is some incompatibility when comparing the results, a Comparison State table will be 

displayed as shown below:  

 

Figure 39: Incompatibility table 

2.5.3 Removing a Comparison case 

After comparing results, it is important to remove the all the results databases from the Comparison 

View. If a results database is not removed from the Comparison View, the model is locked and the 

application will prevent the users from editing it. 

In order to remove a single case from the Comparison View, right-click on the hyperlink with the 

sensitivity case name and select "Remove Comparison Model "name"”, as shown below: 
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Figure 40: Right-click on the Sensitivity Name to Remove the comparison model 

In order to remove all the results databases – select the option to “Remove All Comparison Models”. 

 Maintenance Tab at the Simulator Parameters 

The entire list of keywords related to maintenance have been reviewed and a new interface has been 

designed to make them more accessible and easy to defined: 

 

Figure 41: New “Maintenance” tab at the Simulation Parameters 

The following section provides a quick description of each option:  

 

Default: By default, once a job is started it will be completed by overrunning the shift as required. 

New behaviour: Enforces a strict rule that there is no shift overtime, all jobs are interrupted at the 

end of a shift and re-started on the next day’s shift.  

If the Maintenance profile associated with the repair is of highest priority (i.e. Level 1 (priority 1-5), 

this keyword is ignored. 
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Default: By default, mobilization delay will not be enforced for jobs which have been delayed and 

started on the next day’s shift and on jobs overrunning into the next day’s shift.  

New behaviour: This option enforces a mobilization delay for jobs which have been delayed and 

started on the next day’s shift and on jobs overrunning into the next day’s shift.  

 

This option will align all planned maintenance activities forcing them to start at the same day. To 

define what activities are going to be aligned, the user must input a time range which will align all 

activities within that time range. Enter the number of days between 1 and 90 days. 

 

This option defines the minimum time spent on a job location before the end of a shift, which in turn 

controls the extent of mobilizations. This is to avoid situations for example where a crew arrive on 

location and start a job for a few minutes then are forced to return on the next day’s shift to complete 

the task. 

Enter the number of days between 1 and 90 hours. 

 

Default: By default, once a job is started it will be completed by overrunning the shift(s) as required. 

New behaviour: This option allows the user to stipulate the maximum allowable shift overrun before 

an interrupt is enforced. Enter the number of days between 1 and 90 hours. 

 

By default, all mobilization times less than 1day will be included in the man-hours expended, however, 

this can be overruled by using this keyword permits the user to stipulate an alternative threshold for 

inclusion.  

 

This option will optimise the maintenance resourcing by taking the maximum number of resources 

available and repairing all level 3 maintenance tasks in parallel. 

 

Default: By default, if there is currently a spare restock request in progress, subsequent restock 

requests for that spare will trigger a new order. 

New behaviour: If there is currently a spare restock request in progress, subsequent restock 

requests for that spare will be added to the existing order and be delivered at the same time as the 

original order. 
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This option will enforce travel time between all the locations the maintenance resourcing by taking 

the maximum number of resources available and repairing all level 3 maintenance tasks in parallel. 

 Running models from a server 

Prior to Maros 9.3 a project model would be run directly from a server.  If the network was poor or 

the server was slow this would not normally slow down the simulation time but could slow down the 

results generation time. 

In Maros 9.3 all results processing is now done on the local computers “temporary” folder.  Once 

processing is complete the final results files are copied back to the network directory.  For slow 

networks this should show a major improvement in the time taken to generate results. 

 Improvements to the Interface 

The picture below shows the Home Tab in Maros with a working model loaded.  

 

Figure 42: Maros user-interface 

You will notice the following improvements: 

Zoom Bar: has been moved to the bottom right of the application to allow for more space at the 

Home tab 

 

Figure 43: Zoom Bar 

The Grids button has been removed allowing users to easily access the seven grids available: 

 

Figure 44: Grids Area in the Home Tab 
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The same lay-out has been introduced to the Add Item area: 

 

Figure 45: Add Item in the Home Tab 

The “Switch Windows” button has been moved from the Views tab to the Home Tab: 

 

Figure 46: Switch Windows in the Home Tab 
 

A few features have been extended to give better reporting capabilities. For example, the “Remove 

Bottlenecks” button at the Settings tab now displays all the elements where the capacity has been 

changed. In addition to that, by double-click on any of the messages, the reference node opens. 

 

Figure 47: Message window reporting the changes to the capacities 

Several fixes have been implemented for complex interactions of the animation mode. Extra 

visualisation capabilities are being added to show, for example, flames when flaring operations are 

taking place: 
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Figure 48: Animation mode with on-going flaring operations 

 Minor usability enhancements  

The Simulation Parameters have been changed to align with the reports and a few pre-defined 

parameters have been added: 

 

Figure 49: Simulation Parameters window 

The Operations log has been renamed to align with the actual log name – Event log output. The Cost 

data is now automatically defined to dollars to easy the process of defining lifecycle cost studies. 

In the Flow Grid, users can easily access the property window by right-clicking on the Node name at 

the top of the respective column and selecting “Full Properties [Node name]”. The reference node 

will also be selected the node at the Hierarchical tree, as shown below: 
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Figure 50: New location of the Generate Animation data 

Many users utilise the animation mode to perform quality checks to the model. In order remove one 

step in the process of getting the animation data, the box “Generate Animation data” at the Configure 

Simulator window is now automatically checked. 

 

Figure 51: Configure Simulator 

The batch run functionality has been extended to provide more information in case a model shows a 

fatal error throughout the simulation process.  

The Transient area of the Parallel Grid now displays the name of the parallel unit: 
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Please continue to suggest changes to the interface that facilitates your operation of the model. 

3 MOVING TO MAROS 9.3.1 

At this point, we expect that many models have been converted to the new platform of Maros, Maros 

9. If that’s not the case, we recommend that models are converted so you can take advantage of 

the new features available in Maros 9. 

It is possible to upgrade version 8.5 models to 9.3 however there are some upgrade steps that you 

need to take. If you need any assistance in upgrading a Maros 8.5 model to Maros 9.3 or there are 

any discrepancies between Maros 8.5 and Maros 9.3 inputs or results, please contact 

software.support@dnvgl.com.  

More complex models with multiple separation points require further conversion steps. Switching on 

compatibility mode in Maros 8.5 will aid the upgrade process. 

 Converting models from version 8.5 to version 9.3.1 

When opening models from Maros 8.5 in Maros 9.3.1, two outcomes are possible: 

1. A message will be displayed stating that the conversion process was complete and that you 

must check if the conversion process has been carried out properly. Maros 9.3.1 will always 

create a backup version of the Maros 8 model with the extension jmsp8 at completion of the 

conversion process. 

 

Figure 52 - Conversion complete dialog 

Or 

2. A message stating that the conversion process was not possible. This typically occurs when 

the flow network of Maros 8 has multiple points which could be potentially used as separation 

points or when there are features available in Maros 8 which are currently not supported in 

mailto:software.support@dnvgl.com
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Maros 9.3.1. Following this message another message will appear stating that Maros 9.3.1 

has “Failed to open document." 

 

Figure 53 - Conversion process failure messages 

The compatibility feature is now available in Maros version 8.5 by clicking on  in the toolbar.  

There is an FAQ detailing the conversion and explaining how to resolve issues related to the 

conversion process. You can access the FAQ from the Help tab in Maros 9.3.1 and by choosing the 

Conversion FAQ: 

 

Figure 54: Help Tab 

 Forward compatibility in the new platform: Maros 9 

Forward compatibility is also available for Taro.  

If a model is saved in newer version, users can open in an older version if the model contains no 

newer features. For example, if a Maros 9.3.1 model is saved with the LP Solver defined then it will 

not open in Maros 9.2. The following message will be displayed when trying to load the model in 

Maros 9.2: 

 

If that feature is removed and the model is saved, then it will load into Maros 9.2. 
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 Change of file format 

The file extension has been changed in the new platform Maros 9 to avoid confusion with version 8.x 

files.  

The file formats are: 

Table 3: File formats in Maros 8 and Maros 9.3.1 

Application Document file extension Results file extension 

Old file format: Maros 8 .jmsp .jmsd 

File format: Maros 9.3.1 .dmsp .dmsd 

 

4 FEEDBACK 

Feedback is essential for us to keep improving the user-interface and areas of particular interests 

regarding modelling assets and production scenarios.  

Please let us know of possible gaps that affect what you are or will be modelling. An important point 

is that you shouldn’t ignore minor issues, tell us about them (we don’t always know). 

It is important to get your team together and try to provide a wish list where you address the 

modelling challenges that you, as a company, will be facing soon. 

We won’t be able to do everything but we will prioritise based on the feedback. With this feedback 

our aim is to provide the most comprehensive solution for Oil and Gas RAM analysis in the market. 

5 HOW TO UPGRADE 

This section is intended to give general information regarding downloading, installing and licensing 

Maros 9.3.1. 

 Downloading the installation package 

All DNV GL RAM products can be downloaded via the DNV GL Software’s Customer Portal. In order 

to access the Customer Portal, please use the link below to log into the Customer Portal: 

www.dnvgl.com/cp 

http://www.dnvgl.com/cp
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Figure 55 - DNV GL Software customer portal 

After logging in to the Customer Portal, select the option “Get Software”, as shown below: 

 

Figure 56 - Home tab of customer portal 

By clicking Get Software you are taken to the Software Downloads Tab. Click Select Maros/Taro 

Library from the View dropdown list as shown in Figure 57. 
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Figure 57: View dropdown list 

Maros 9.3.1 will be listed at the top and marked as “Latest Version”. 

 

Figure 58: Maros 9.3.1 at the Customer Portal 



   

| Release Notes | Maros 9.3.1 | June 2017 | www.dnvgl.com/software  Page 38 

 

 

Figure 59: Maros 9.3.1 download page at the Customer Portal 

Click the “Download” button to download the Maros 9.3.1 installation files. 

 Maros 9.3.1 Installation Process 
The Maros 9.3.1 installation process will not override the existing version of Maros 8 but it will 

override the existing Maros 9.3 installation. You can therefore keep Maros 8 and 9.3.1 of Maros 

installed. 

Once the download is complete, you should: 

1. Check if you have windows administrator rights. 

2. Extracting and running the installation package 

 

In order to install the program, you must have administration rights for the computer. Contact 

your System Administrator to check whether you have administration rights, or to obtain these 

rights. 

Unzip the content from the zip file to your local hard drive and click on the Quickstart.html as 

shown in picture below. Please do not try to run the Quickstart.html file from within the Zip file 

before the files are uncompressed as this may cause your installation to fail. 
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Figure 60: Quickstart.html 

This will prompt your default browser to open. Simply click on “start the installation” at the bottom 

of the page, accept the installation to install the application and the process will be started.  

 

Figure 61: Start the installation 

If Microsoft .Net 4.6 is not installed on your system, this tool must be installed before installing Maros. 

In order to install this tool, please go to the Installation section at the Quickstart.html file and select 

the link Microsoft .Net 4.6 Installation (English). 
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Figure 62 - Microsoft .Net 4.6 Installation (English) 

Note: For another languages Microsoft .Net 4.6 can be installed directly from Microsoft or contact 

your IT department. 

 License for Maros 9.3.1 
If you already have a license file for 8 or 9.2, no license request or import is required to start using 

Maros 9.3.1. 

In case you face any issues regarding license please contact DNV GL Software support team at 

Software.Support@dnvgl.com. 

6 MAKING THE MOST OF THE DOCUMENTATION 

Maros 9.3.1 presents different sources of information. Please find below a description of each of them:  

User Manual 

The Maros folder in the installation (typically under “Program Files (x86)\DNVGL”) contains a Maros 

user guide called Manual.pdf, which provides you with a wide range of information about the program, 

and should enable you to find answers to most of the questions you may have about Maros. The 

Maros guide contains all the Online Help pages and more and should be the main resource of 

information about the software.  

Help system 

The Online Help for Maros 9.3.1 is in the form of a *.chm file—a compiled HTML Help file. The file 

will be installed with the rest of the Maros files when you install the program, and you will normally 

access it using the Help menu, but you can also open and read the file directly (located in the Maros 

installation folder). 

In order to read the files, you must have Microsoft Internet Explorer Version 5 or later installed on 

your PC, although it does not have to be your default browser. You must also have some additional 

files that are specific to Microsoft HTML Help; these are installed automatically during the Maros 

setup process, so you should be able to read the files directly if you have already installed Maros. 

mailto:Software.Support@dnvgl.com
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Frequently Asked Questions 

To ease the transition between generation 8 and 9.3.1, the installation package comes with a number 

of Frequently Asked Questions. These documents try to highlight the main differences between the 

two generations and explain the new approach used by Maros 9.3.1. 

The areas covered by the FAQs are: 

- Building a model in 6 steps 

- Maintenance modelling in 4 steps 

- Debottlenecking 

- Conversion process 

- Quick steps 

- Criticality analysis 

- Design capacity 

- Flow network 

- Flow table 

- Parallel block 

- Shipping modelling 

- Tank modelling 

- Well boosting 

- Flaring Modelling 

You can find these FAQs under the Help Menu: 

 

Figure 63: FAQs button in the Help tab 

Clicking on FAQs button will prompt your default browser with a list of FAQs: 
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Figure 64: List of FAQs 

Clicking on any item on the list will prompt another tab with the FAQ: 

 

Figure 65: FAQ document 

You can also see the FAQs under the Maros 9.3.1 folder inside C:\Program Files 

(x86)\DNVGL\Maros9\FAQ. 
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Figure 66: FAQ folder 

In case you need more information about a specific modelling approach or feature, please contact 

DNV GL Global support. 

Blog 

DNV GL Software’s blog discusses topical issues, challenges and market observations relevant for 

software for managing risk and improving asset performance: 

 

Figure 67: Blog button in the Help tab 

Videos 

Maros and Taro e-learning centre has been designed to support clients that are new to Maros and 

Taro.  
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Figure 68: Video button in the Help tab 

The idea is that we can add more videos to Maros and Taro e-learning centre so please get in touch 

with ideas of what you would like to see there. 

The videos currently available are: 

 Building up a model in 6 steps: This video describes the six main steps to build-up a Maros 

model.  

 Maintenance Resource Modelling in Maros and Taro: This video takes the model we created 

in the “Building up a model in 6 steps” and extends the model to account for Maintenance 

Resources Modelling.  

 Priority of Maintenance tasks: This video takes the model we created in the “Maintenance 

Resource Modelling in Maros and Taro” and extends the model to account for maintenance 

repair priority. 

 Lifecycle cost analysis: This video takes the model we created in the “Maintenance Resource 

Modelling in Maros and Taro” and extends the model to account for Lifecycle cost analysis.  

 Multi-product modelling and Production Capacities: This video describes how users should 

use the model multi-products in Maros.  

 Flaring operations: This video takes the model we created in the “Multi-product modelling 

and Production Capacities” and extends the model to account for flaring operations. 

 New Interface in Maros and Taro: This video describes the advantages of the new interface 

in Maros 9.2.  

 Implementing Planed Renewals using Maros and Taro: This video describes how to implement 

planned renewals in Maros.  

Optimising frequency of Planned Renewals: Sensitivity Manager can be used to optimize the 

frequency of Planned Renewals. 

 

 

Tutorials 

The tutorials have been separated into two categories:  

- Guidelines on building models and; 

- Simple walk through modelling capabilities. 

https://www.youtube.com/playlist?list=PL2EsH0WLHwszPBoEOizgc_nKLotGFjAuz
https://www.youtube.com/watch?v=N1OZQCl6WDQ
https://www.youtube.com/watch?v=Xsk2T3G6yYE
https://www.youtube.com/watch?v=m4wR5c7ZkuQ
https://www.youtube.com/watch?v=VuXYAIXicEw
https://www.youtube.com/watch?v=ejOEoydBINw
https://www.youtube.com/watch?v=8kudvwBlW-I
https://www.youtube.com/watch?v=eupsny0ubeQ
https://www.youtube.com/watch?v=ueBDoFL-jpI
https://www.youtube.com/watch?v=wlORIdw1f3I
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For the “Guidelines on building models” category, users are led through the main steps to build either 

a full model or a section of a model.  

For the “Simple walk through modelling capabilities” category, users are advised to open a reference 

model to follow the steps described on the tutorials. 

Each tutorial is intended to focus on a specific set of features and asset. Obviously, the experience 

acquired when performing the tasks can be extended to model other scenarios/assets. 

You can find the tutorials at Help Tab by clicking on Tutorials.  

 

Figure 69: Tutorial button 

This will prompt another window: 

 

Figure 70: Tutorials folder 

In addition, Tutorials can be found in the Content tab of DNV GL’s Customer Portal. Choose the 

Content tab and select Maros/Taro library. Then search for “Tutorial” – a list of all the tutorials will 

be shown: 



   

| Release Notes | Maros 9.3.1 | June 2017 | www.dnvgl.com/software  Page 46 

 

 

Figure 71: Searching at Maros/Taro library for tutorials 

Release Notes 

These Release Notes are supplied in the Help tab, as shown below. 

 

Figure 72: Release Notes at the Help Tab 

You can also find it in *.PDF form, for future reference in the installation folder. 

7 TECHNICAL HELP 

There are two options to contact DNV GL global support group: 

Report a Problem Feature 

To keep improving the user experience and stability of Maros and Taro, it is important for us to 

receive feedback in regards to any problems faced during the modelling process or even a feature 

request and change suggestion. This report can be easily sent to our Global support group by using 

the “Email Software Support” button at the Help tab. 
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Figure 73: Help tab 

The process is simple. It consists of completing the form shown in the Figure 74 below. The Support 

Feedback application will then gather all the relevant information including operating system, 

software version and opened study files and send it to DNV GL Software Global Support group.  

 

Figure 74: Report a problem form 

When completing the form, it is also very important to provide as much information as possible to 

help us understand the problem and provide a fast and proper solution. 

You can select between three options: 

 

Figure 75: Report type 

The email report can be copied to other people by selecting the "Cc…" button and entering the 

necessary email addresses. On completion of these steps press the Send button. 

You can follow up your cases and development requests at the Customer Portal. 

All you must do is log into the Customer Portal and select the Cases tab, as shown below:  
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Figure 76: Cases at Customer Portal 

Direct email 

If you need advice on using Maros or specific detailed technical information, you can also contact 

software.support@dnvgl.com. 

mailto:software.support@dnvgl.com
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8 FOR SYSTEM ADMINISTRATORS: TECHNICAL NOTES 

These notes give technical details to help you improve the performance of Maros 9.3.1 on your system. 

They are aimed mainly at secondary support personnel (e.g. IT professionals), but may be useful for expert 

users. 

System Requirements 

Maros uses computational techniques that will depend strongly on the performance of the CPU. In general, 

the more powerful the CPU, the better the user experience. Multi-core processors, however, will not benefit 

the calculation speed greatly except for batch mode because the software does not yet optimize 

performance on multi-core CPUs. So, a twin-core CPU with a higher clock speed will probably outperform 

a quad-core CPU with a lower clock speed. Study size is another factor and users with large studies will 

benefit from as much memory as possible. 

The requirements for version 9.3.1 are as follows: 

Table 4: System Requirements 

 
Minimum Requirements 

(small models) 
Recommended 

Operating System: 

Windows Vista (32-bit versions) 

Windows 7 (32/64-bit versions) 

Windows 8 (32/64-bit version) 

Windows 10 (32/64-bit version) 

Windows 7 (64-bit versions) 

Computer Processor*: Intel Core or equivalent Quad Core Intel Core i5/i7 

Computer Memory: 2 GB 8 GB or more 

Clock speed (MHz) 800 MHz 3GHz or higher 

Internet Browser Supported version of Internet Explorer. 

Screen Resolution: A resolution with a minimum height of 720 pixels 

Hard disk space (MB) 650 MB (plus around 2GB of temporary disk space) 

Optional 

Requirements 

Some features depend on having Microsoft Excel installed. The product is 

tested with Office 2010 and more recent versions. 

* Note: simulation time is related to the processor speed so the faster the CPU the sooner the simulations run. 

  



 

 

 

 

ABOUT DNV GL 
Driven by our purpose of safeguarding life, property and the environment, DNV GL enables organizations to 

advance the safety and sustainability of their business. We provide classification and technical assurance 

along with software and independent expert advisory services to the maritime, oil and gas, and energy 

industries. We also provide certification services to customers across a wide range of industries. Operating 

in more than 100 countries, our 16,000 professionals are dedicated to helping our customers make the 

world safer, smarter and greener. 

SOFTWARE  

DNV GL is the world-leading provider of software for a safer, smarter and greener future in the energy, 

process and maritime industries. Our solutions support a variety of business critical activities including 

design and engineering, risk assessment, asset integrity and optimization, QHSE, and ship management. Our 

worldwide presence facilitates a strong customer focus and efficient sharing of industry best practice and 

standards. 

 


